
Cite as: Dantas, M. et al. (2024). Dissecting the Mechanical Control of Mitotic Entry Using a Cell Confinement Setup. 

Bio-protocol 14(6): e4959. DOI: 10.21769/BioProtoc.4959. 

Copyright: © 2024 The Authors; exclusive licensee Bio-protocol LLC. 

This is an open access article under the CC BY-NC license (https://creativecommons.org/licenses/by-nc/4.0/). 

 

 

1 

 

Published: Mar 20, 2024 

Open Access 

Dissecting the Mechanical Control of 

Mitotic Entry Using a Cell Confinement 

Setup 
 

Margarida Dantas1, Débora Vareiro2 and Jorge G. Ferreira2, 3, * 

 
1University Medical Center Utrecht, Center for Molecular Medicine, Utrecht, The Netherlands 
2Instituto de Investigação e Inovação em Saúde (i3S), Universidade do Porto, Porto, Portugal  

3Dept. Biomedicina, Faculdade de Medicina da Universidade do Porto, Porto, Portugal 

*For correspondence: jferreir@ibmc.up.pt  

 

Abstract 
Proliferating cells need to cope with extensive cytoskeletal and nuclear remodeling as they prepare to divide. These 

events are tightly regulated by the nuclear translocation of the cyclin B1-CDK1 complex, that is partly dependent on 

nuclear tension. Standard experimental approaches do not allow the manipulation of forces acting on cells in a time-

resolved manner. Here, we describe a protocol that enables dynamic mechanical manipulation of single cells with high 

spatial and temporal resolution and its application in the context of cell division. In addition, we also outline a method 

for the manipulation of substrate stiffness using polyacrylamide hydrogels. Finally, we describe a static cell confinement 

setup, which can be used to study the impact of prolonged mechanical stimulation in populations of cells. 

 

 

Key features 
• Protocol for microfabrication of confinement devices.  

• Single-cell dynamic confinement coupled with high-resolution microscopy. 

• Static cell confinement protocol that can be combined with super-resolution STED microscopy. 

• Analysis of the mechanical control of mitotic entry in a time-resolved manner. 

 

Keywords: Cell confinement, Cyclin B1, G2-M transition, Hydrogels, Live-cell microscopy, Mechanical forces, Mitotic 

entry, Nucleus 
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Graphical overview 
 

 

 

 

Background 
 

As proliferating cells prepare to enter mitosis, they undergo a series of biochemical and morphological changes that 

contribute to the assembly of the mitotic machinery and the efficiency of chromosome segregation [1]. Many of 

these changes are regulated by the activity and subcellular localization of the cyclin B1-CDK1 complex [2,3]. 

Notably, nuclear translocation of cyclin B1 seems to be essential to ensure full activity of the complex, as it 

stimulates its own nuclear import [3] through the nuclear pore complexes, triggering a positive feedback mechanism 

[4]. While the biochemical pathways that regulate the activity and localization of the cyclin B1-CDK1 complex 

have been well established [5], the contribution of mechanical forces to these processes remained unknown. We 

have recently identified a tension-dependent signal on the prophase nucleus that fine-tunes cyclin B1 translocation 

across the nuclear pores, setting the time for mitotic entry [6]. We further show that this signal relies on actomyosin 

contractility that leads to an unfolding of the nucleus and increased tension on the nuclear envelope (NE). Overall, 

we propose that mechanical forces are an important contributor for mitotic entry.  

Here, we describe a protocol that enables the mechanical manipulation of cells during mitotic entry with high 

temporal and spatial resolution in single cells undergoing mitosis. This method allows the implementation of cell 

confinement techniques [7] in combination with high- (spinning-disk) and super-resolution (STED) microscopy to 

probe how mitotic entry is mechanically regulated. We provide step-by-step instructions on cell seeding, preparation 

of the confinement slides, assembly of the confinement devices, live-cell imaging, and data analysis. Moreover, we 

explain how to generate coverslips coated with polyacrylamide (PAA) hydrogels of calibrated stiffness that can be 

used in combination with high-resolution spinning-disk live-cell imaging. Finally, we describe an experimental 

setup that allows the long-term confinement of cell populations for fixed-cell immunofluorescence analysis. While 

these are used in the context of cell division, these methods could be easily adapted to other experimental settings. 

 

 

Materials and reagents 
 

Biological materials 

 

1. RPE-1 parental cell line, already available in the lab 

2. RPE-1 expressing endogenously tagged with H2B-GFP and tubulin mRFP, already available in the lab 

3. RPE-1 cell line expressing exogenous cyclinB1-Venus (gift from Jonathon Pines) 

4. RPE-1 cell line expressing cyclinB1-Venus/tubulin-mRFP, generated in our lab by transduction with lentiviral 

vectors containing pRRL-mRFP-α-tubulin 

5. shRNAi-ROCK1-LV to deplete ROCK1 (gift from João Relvas) 

6. RPE-1 cell line expressing exogenous cGAS-GFP (gift from Matthieu Piel) 

7. RPE-1 cell line expressing GFP-NLS/tubulin-mRFP, created by lentiviral transduction using a pCDJ-NLS-

copGFP-EF1-BlastiS plasmid (Addgene, catalog number: 132772) 

8. RPE-1 cell lines expressing exogenous LBR-mCherry and endogenous cyclinB1-Venus/LBR-mCherry, 

generated by lentiviral transfection using a plasmid pWPT LBR-mCherry (gift from Stephen Royle) 
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9. DN-KASH plasmid (gift from Edgar Gomes) 

10. Rap1Q63E plasmid (gift from Jean de Gunzburg) 

 

Reagents 

 

1. RO-3306 (Santa Cruz Biotechnology, catalog number: sc-358700A), used at 9 mM for 16 h 

2. Importazole (gift from Helder Maiato), used at 40 mM for 2 h 

3. Y-37632 (Sigma-Aldrich, catalog number: Y0503), used at 5 mM for 30 min 

4. AACOCF3 (TOCRIS, catalog number: 1462), used at 20 μM for 30 min 

5. BAPTA-AM (Abcam, catalog number: ab120503), used at 10 μM for 15 min 

6. 2APB (Abcam, catalog number: ab120124), used at 10 μM for 30 min 

7. Para-nitro-blebbistatin (MotorPharma, catalog number: 1621326-32-6), used at 50 μM for 30 min 

8. ML-7 (Merck, catalog number: I2764), used at 50 μM for 30 min 

9. Cytochalasin D (Biogen Cientifica, catalog number: TO-1233), used at 0.5 μM for 30 min 

10. Nocodazole (Merck, catalog number: M1404), used at 3.3 μM for 30 min 

11. BI2536 (Axon Med Chem, catalog number: AXON 1129), used at 200 mM for 2 h 

12. Etoposide (Selleck Chemicals CO., catalog number: S1225), used at 1 μM for 2 h 

13. Thymidine (Sigma-Aldrich, catalog number: T1895), used at 2 mM for 16 h followed by a 10 h release 

14. Dimethyl sulfoxide (DMSO) (Sigma-Aldrich, catalog number: D4540) 

15. Lipofectamine 2000 (Invitrogen, catalog number: 11668019) 

16. Lipofectamine RNAiMAX (Invitrogen, catalog number: 13778150) 

17. Dulbecco’s Modified Eagle Medium (DMEM) (Corning, catalog number: 10-013-CV)  

18. Fetal bovine serum (FBS) (Gibco, catalog number: 11550356) 

19. Fibronectin (FBN) (Sigma, catalog number: F1141) 

20. Leibovitz’s-L15 medium (Life Technologies, catalog number: 11415064) 

21. Antibiotic-Antimycotic 100× (Life Technologies, catalog number: 15240096) 

22. Bind-Silane (Sigma, catalog number: M6514) 

23. Acetic acid (glacial) 100% (Merck, catalog number: 1.00063) 

24. 40% (w/v) acrylamide stock solution (Bio-Rad, catalog number: 1610140) 

25. 2% (w/v) bis-acrylamide stock solution (Bio-Rad, catalog number: 1610142) 

26. PDMS crosslinker A + B (Momentive, catalog number: RTV615) 

27. Isopropanol (Merck, catalog number: 1.09634) 

28. dH2O 

29. Trypsin (TrypLE Express Enzyme 1×) (Thermo Fisher Scientific, catalog number: 12605010) 

30. Trypan Blue solution 0.4% (Gibco, catalog number: 15250061) 

31. Sodium hydrogen carbonate (NaHCO3) (Sigma-Aldrich, catalog number: S6014) 

32. Sodium chloride (NaCl) (Sigma-Aldrich, catalog number: 31434) 

33. Potassium chloride (KCl) (Merck, catalog number: 1.04936) 

34. Dissodium hydrogen phosphate (Na2HPO4) (Merck, catalog number: 1.06586) 

35. Potassium dihydrogen phosphate (KH2PO4) (Merck, catalog number: 1.04873) 

36. Absolute ethanol (Sigma-Aldrich, catalog number: E7148) 

37. Hydrochloric acid (HCl) 37% (Merck, catalog number: 1.00317) 

38. Sodium hydroxide (NaOH) (Merck, catalog number: 1.06498) 

 

Solutions (see note 1) 

 

1. 10% acetic acid (see Recipes) 

2. Bind-silane solution (see Recipes) 

3. Phosphate buffered saline (PBS) 10× (see note 2) (see Recipes) 

4. Fibronectin (FBN) solution (see note 3) (see Recipes) 

5. 70% ethanol (see Recipes) 
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Recipes 

 

1. 10% acetic acid 

Reagent Final concentration Quantity or Volume 

Acetic acid (glacial) 100%  10% (v/v) 10 mL 

Absolute ethanol  n/a 90 mL 

Total n/a 100 mL 

 

2. Bind-silane solution 

Reagent Final concentration Quantity or Volume 

Acetic acid 10% 5% 2.5 mL 

Bind silane  0.3% 15 μL 

Absolute ethanol n/a 2.485 mL 

Total n/a 5 mL 

 

3. Phosphate buffered saline (PBS) 10× 

Reagent Final concentration Quantity or Volume 

NaCl  1.37 M 80 g 

KCl 0.027 M 2 g 

Na2HPO4 0.1 M 14.4 g 

KH2PO4 0.018 M 2.4 g 

H2O n/a Top up volume for 1 L 

Total n/a 1 L 

 

4. Fibronectin (FBN) solution 

Reagent Final concentration Quantity or Volume 

FBN 25 mg/mL 25 mg 

NaHCO3 pH 8.6a 100 mM Top up volume for 1 mL 

Total n/a 1 mL 
a Dilute 84 mg of NaHCO3 (MW = 84.01 g/mol) in 10 mL of ddH2O and adjust the pH to 8.6. Store at room 

temperature. 

 

5. Ethanol 70% solution 

Reagent Final concentration Quantity or Volume 

Absolute ethanol 70% 700 mL 

dH2O n/a Top up volume for 1 L 

Total n/a 1 L 

 

Laboratory supplies 

 

1. FluoroDishes (WPI, catalog number: FD-35-100) 

2. Round glass coverslips 10 mm thickness #1.5 (Fisher Scientific, catalog number: NC1272767) 

3. Square glass coverslips 22 mm × 22 mm thickness #1.5 (Corning, catalog number: 2850-22) 

4. Microfabricated coverslips with confining pillars 

5. 6-well cell culture plate (Corning, catalog number: CLS3516) 

6. 6-well static confiner (4DCell, catalog number: CSOW 620) 

7. T25 cell culture flasks (Sarstedt, catalog number: 83.3910) 

8. Scotch Magic tape (3M, catalog number: 8-1933) 

9. Parafilm M (Fisher Scientific, catalog number: 10018130) 

10. Scalpel blade or razor blade 

11. Fine forceps (Fine Science Tools, catalog number: 11254-20) 
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12. SU-8 mold with micropillar design (either custom-designed or ordered from MesoBioTech, France) 

13. Harris Uni-Core puncher (0.75 mm) (WPI, catalog number: 504529) 

14. Disposable 5 mL sterile pipettes (nerbe plus, catalog number: 12-441-9105) 

15. Disposable 10 mL sterile pipettes (nerbe plus, catalog number: 12-461-9108) 

16. Disposable 50 mL centrifuge tubes (Corning, catalog number: 734-1868) 

17. Disposable 15 mL centrifuge tubes (Corning, catalog number: 734-1812) 

18. Cell counting slides (Bio-Rad, catalog number: 1450011) 

 

 

Equipment 
 

1. Temperature-controlled TE2000 microscope equipped with a modified Yokogawa CSU-X1 spinning-disk head 

(Yokogawa Electric), an electron multiplying iXon+ DU-897 EM-CCD camera (Andor), and a filter wheel 

(Nikon) 

2. Immersion oil 60× 1.4NA Plan-Apo DIC objective (Nikon) 

3. Dynamic cell confiner (adapted from Le Berre et al. [7]) 

4. AF-1 dual vacuum/pressure controller (Elveflow) 

5. 6-well confinement device (4DCell, France) 

6. Low-pressure plasma cleaner (Zepto, Diener Electronics, Germany) 

7. Centrifuge 

8. Hot plate 

9. pH meter  

10. Electronic TC10TM/TC20TM cell counter device 

11. Vacuum degasser (optional) 

12. 37 °C humidified CO2 (5%) incubator  

13. Laminar flow hood 

 

 

Software and databases 
 

1. NIS Elements AR software (Nikon) 

2. ImageJ (version 1.54) 

3. Custom-designed MATLAB algorithm for nuclear pore analysis (The MathWorks Inc, USA; v2018b) 

 

 

Procedure 
 

A. Preparation of cell confinement setup (see note 4) 

 

1. Preparing the PDMS suction cup (Figure 1A) 

a. Mix the PDMS crosslinker A with the PDMS crosslinker B in a 10/1 mixture (w/w). 

b. Mix until it is homogenous and centrifuge (150× g) for 5 min to remove all air bubbles. Alternatively, 

degas the PDMS mixture in a vacuum degasser for 5 min. 

c. Pour the mixture on top of the custom-made mold (design instructions obtained from Le Berre et al. 

[7]) and let it bake for 1 h on a hot plate at 80 °C. 

d. Create a hole on the side of the PDMS suction cup using a Harris Uni-Core puncher (0.75 mm). 
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Figure 1. Overall workflow for preparation of a dynamic cell confinement setup. A. Prepare a PDMS 

suction cup using a mold (design instructions available from Le Berre et al. [7]). B. Prepare either a PDMS 

confinement slide for rigid confinement with the desired micropillar height or a polyacrylamide (PAA) 

confinement slide for elastic confinement. C. Bind confinement slide to the PDMS suction cup. D. Seed cells 

on a 35 mm dish, previously coated with fibronectin (FBN). E. Remove the lid of the 35 mm dish and assemble 

the confinement device on top of the dish. Turn on the vacuum pump to secure the confinement device in place 

and confine cells. F. Representative time-lapse images of a cell undergoing multiple rounds of dynamic 

compression during mitosis. Timelapse is 2 min and scale bar is 10 mm. 

 

2. Preparing the PDMS confinement slide for rigid confinement (Figure 1B) 

a. Prepare a mix of PDMS with a crosslinker A/B mixture with a ratio of 10/1 (w/w). 

b. Mix until it is homogenous and centrifuge (150× g) for 5 min to remove all air bubbles. Alternatively, 
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degas the PDMS mixture in a vacuum degasser for 5 min. 

c. Plasma-treat the 10 mm glass coverslips for 2 min. This step will activate one side of the coverslips 

and promote the binding of the glass with the PDMS layer in the next step. 

d. Distribute drops of the PDMS mix on the SU-8 wafer mold with the micropillars of desired height (in 

this case, 8 μm) and place a coverslip on top of each drop, making sure the plasma-treated side is 

facing the PDMS. It is important to ensure a very thin layer of PDMS under the coverslips. 

e. Bake the wafer with the coverslips on a hot plate at 95 °C for 15 min. Remove excess PDMS by 

washing with isopropanol and using a scalpel and forceps, being careful not to scratch the SU-8 mold. 

f. Place a drop of isopropanol on the wafer next to the slides to peel off the confinement slides. Using a 

razor blade or scalpel, carefully lift the glass coverslips with the PDMS pillars (8 μm height) from the 

wafer. 

3. Preparing the confinement slide with PAA hydrogels for elastic confinement (Figure 1B) 

a. The confinement slides are prepared on 10 mm coverslips. The coverslips are initially treated with air 

plasma for 2 min using a plasma cleaner.  

b. After cleaning, incubate the coverslips with a solution of 0.3% Bind-silane + 5% acetic acid in ethanol. 

Spread the mixture on top of the coverslips and make sure the entire surface of coverslip is covered 

in solution. Let the solution dry by evaporation. 

c. Rinse the coverslips once with 70% ethanol and leave to dry again. 

d. Prepare a gel mixture corresponding to approximately 15 kPa of stiffness. Full details are available in 

Le Berre et al. [7]. Place a drop of the mixture (25 μL) on a parafilm strip and place a silanized 

coverslip on top (silanized side facing the mixture). Allow the gel to polymerize. 

e. Carefully lift the coverslip with the gel from the parafilm using a razor blade or scalpel, making sure 

the gel remains attached to the coverslip. 

f. Hydrate gels with at least 1 mL of PBS for 5 min and then incubate with cell culture medium for at 

least 30 min (see notes 5 and 6). 

 

B. Dynamic cell confinement 

 

1. Seeding RPE-1 cells for confinement 

a. Plasma-treat a fluorodish using the plasma cleaner (2 min air exposure).  

b. Coat the clean fluorodish with 50–100 mL of FBN for at least 30 min. Gently rinse with 2 mL of 

dH2O.  

c. Wash cells growing on a T25 flask with 5 mL of room-temperature PBS. Aspirate the PBS, add 2 mL 

of trypsin, and incubate the cells at 37 °C for 5 min (see notes 7, 8, and 9).  

d. Resuspend cells by gently pipetting up and down, collect the cell suspension, and add 5 mL of fresh 

medium. 

e. Determine the number of cells in your sample using an electronic cell counter. Calculate the volume 

of cell suspension needed for a recommended seeding density of 1.5 × 105 cells per fluorodish. 

f. Place the corresponding number of cells in the previously coated fluorodish (see note 10) and add 2 

mL of cell culture medium supplemented with Antibiotic-Antimicotic (Figure 1D, E).  

g. Let the cells grow overnight at 37 °C in a humidified incubator with 5% CO2. 

h. Once RPE-1 cells are adherent and whenever necessary, transfections with the DN-KASH, Rap1Q63E, 

or shRNAi-ROCK1-LV plasmids are done using Lipofectamine2000 or Lipofectamine RNAiMAX, 

according to the manufacturer's instructions. 

2. Using the dynamic cell confiner (Figure 1E, F) 

a. Before imaging, change the medium of the RPE-1 cells to Leibovitz’s-L15 medium (500 μL, see note 

11) supplemented with antibiotics. If using any of the drugs described in the Reagents section 

(Reagents 1–13) or their corresponding DMSO control, they should be added at this point and cells 

should be incubated for the corresponding time as described in the reagents list. 

b. Carefully dry the back of the confinement slide with absorbing paper and attach it to the piston of the 

suction cup device. If the glass side of the confinement slide is not completely dry, it will not stick to 

the PDMS piston of the suction cup, causing it to detach during imaging. 
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c. Attach the PDMS suction cup to the vacuum generator apparatus and set the pressure to zero (see 

notes 12 and 13).  

d. Place the 35 mm dish with the RPE-1 cells on the microscope. To start the experiment, carefully 

remove the lid of the fluorodish, place the suction cup on top of the fluorodish, and lower the pressure 

of the vacuum generator to -30 mbar until the suction cup is firmly attached to the bottom of the 

fluorodish, without compressing the cells. 

e. Start imaging.  

f. Lower the pressure on the vacuum generator until it reaches -100 mbar.  

g. Confirm on the microscope if the cells remain in focus and compression is visible. 

h. When adding drugs to the cells, slowly increase the pressure on the vacuum generator to allow the 

PDMS suction cup to detach. 

i. Without removing the PDMS suction cup, add the drug to the imaging medium and mix carefully by 

gently pipetting up and down. 

j. To compress cells again, decrease the pressure on the vacuum generator to -100 mbar. 

k. Confinement can be modulated at any time by either decreasing or increasing the pressure on the 

vacuum line (see notes 12 and 13). 

 

C. Static cell confiner 

 

For static confinement experiments, we used a commercially available 6-well confinement device with custom-

designed confinement slides (see note 4) that were prepared using 10 mm standard round microscope coverslips 

and designed with regular hole arrays (diameter 449 μm, 1 mm spacing), similar to what was published 

previously in Le Berre et al. [7]. 

 

1. Preparing the confinement slides  

To prepare the confinement slides, use the same method outlined above in step A2 or A3, depending on 

whether you require rigid or elastic confinement, respectively. 

2. Seeding cells for confinement 

a. Plasma-treat a 6-well plate or 22 mm × 22 mm square coverslips with air plasma for 2 min, depending 

on your need. 

b. Coat the 6-well plate or the coverslips with FBN (see note 10) and incubate at room temperature for 

at least 30 min. Rinse with dH2O.  

c. If your experiment requires the use of 22 mm × 22 mm square coverslips, place one coverslip in each 

well of the 6-well plate using a fine forceps. 

d. Wash cells with 5 mL of room-temperature PBS. Discard the PBS, add 2 mL of trypsin, and incubate 

the cells at 37 °C for 3–5 min (see notes 7, 9, and 14). 

e. Add fresh DMEM medium supplemented with FBS, resuspend, and collect the cellular suspension. 

f. Determine the number of cells in your sample using an electronic cell counter (see note 15). Calculate 

the volume of cell suspension needed for a recommended seeding density of 1.5 × 105 cells per well. 

g. Place the corresponding number of cells in the wells and add 2 mL of cell culture medium 

supplemented with antibiotics (see note 8).  

h. Allow cells to adhere to the substrate at 37 °C in a humidified incubator with 5% CO2. 

3. Assembly of the 6-well confinement device 

a. Rinse the microfabricated confinement slide with 70% ethanol and air-dry with compressed air. 

b. Clean the PDMS pistons supplied with the static confiner (4DCell, CSOW 620) with 70% ethanol. If 

the PDMS pistons have dust particles, remove them with Scotch Magic tape and rinse once again with 

70% ethanol (see note 16). 

c. Place the PDMS pistons on the lid of the 6-well confiner device. Ensure that the PDMS spacers are 

aligned with the holes in the lid (see note 17). 

d. Attach each confinement slide to the PDMS piston by carefully pressing the glass side of the 

confinement slide against the PDMS piston. Ensure that the slides are well centered on the pistons 

and avoid creating air bubbles between the two surfaces.  
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e. To equilibrate the PDMS, place the lid of the confinement device containing the PDMS pistons and 

the confinement slides on a regular 6-well plate. Ensure the confinement device is set to “resting 

position.” Add sufficient cell culture medium to submerge the slides and incubate for at least 1 h at 

37 °C in a humidified incubator with 5% CO2 (see note 18). 

4. Imaging with the static confiner 

a. Approximately 30 min before using the cells, change the medium of the RPE-1 cells to Leibovitz’s-

L15 medium supplemented with antibiotics.  

b. After equilibrating the PDMS confinement slide (see step C3e), transfer the lid of the confinement 

device to the 6-well plate where your cells are seeded. Gently pull down the metal springs on the 

confinement lid, one by one, to attach the lid to the bottom of the 6-well plate. 

c. Place the cells on the microscope and start imaging. 

d. To confine the cells, gently and simultaneously press the locks on both sides of the confinement lid 

down. At this point, the pressure imposed by the lid on the PDMS pistons will induce confinement of 

the cells.  

e. If the experiments require addition of drugs (Reagents 1–13) or the corresponding DMSO control, 

they can be added through the holes present on the lid of the confinement device (see notes 17 and 

18). After addition of the drugs, mix by carefully shaking the 6-well plate. 

f. To release the confinement, gently pull out the locks on the lid of the 6-well confinement device. This 

will release the pressure on the PDMS pistons. 

5. Using the static confiner for fixed cell analysis 

a. For experiments involving fixed-cell imaging, follow the instructions provided in the previous 

sections (steps C1–C4), until the moment of adding fixative to the cells. 

b. Fixative is added through the holes on the lid of the confinement device. Alternatively, the lid can be 

removed and cells fixed immediately after release of confinement. 

c. Incubate cells with fixative for 10 min at room temperature. 

d. After fixation, use your standard immunofluorescence protocol to label cells. 

 

 

Data analysis 
 

1. Quantification of cellular parameters after dynamic, single-cell confinement was done using ImageJ. Initially, 

the efficiency of the confinement was determined by measuring cell height. 

a. Open the images using ImageJ. 

b. Adjust brightness and contrast by clicking Image > Adjust > Brightness and Contrast > Auto. 

c. Prepare the lateral projections. Click Image > Stacks > 3D project. Do the lateral projections for both the 

xz and yz axes.  

d. Combine the lateral projections in the SUM projection of the movie.  

e. Measure cell height by determining the size occupied by the cells in the lateral projections. Select the cells 

that were confined to a maximum of 8 mm of height (see note 19). 

2. In our specific case, we wanted to analyze the effect of mechanical confinement on the nuclear translocation of 

cyclin B1. To quantify the levels of cyclin B1 inside the nucleus, ImageJ was used: 

a. Draw a small region of interest (ROI) and add it to the manager (Edit > Selection > Add to manager).  

b. Measure cyclin B1 intensity by selecting Analyze > Measure. Copy the values to an Excel sheet. 

c. Using the same ROI from the Manager, select a region outside of the cell and measure the background 

fluorescence intensity. Copy the values to an Excel sheet. 

d. Background-correct the fluorescence intensity values by subtracting the background fluorescence intensity 

from the cyclin B1 fluorescence intensity measured in 2b.  

e. Normalize nuclear cyclin B1 fluorescence intensities by dividing the fluorescence intensity of each time 

point with the lowest intensity level of cyclin B1. 

f. To obtain a measure of cyclin B1 nuclear translocation rate, align fluorescence values for all cells relative 

to the lowest nuclear intensity. The time point corresponding to the lowest nuclear fluorescence intensity 

was defined as zero.  
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g. To correlate cyclin B1 translocation with the time of nuclear envelope permeabilization (NEP), the 

fluorescence intensity values were normalized and aligned relative to the accumulation of tubulin in the 

nucleus, which acts as a proxy for the loss of the nuclear barrier function. 

 

A minimum of three independent experiments is recommended, with at least 30 cells analyzed for each condition. 

Normality of the samples was assessed using the Kolmogorov-Smirnov test. In comparing multiple groups with a 

normal distribution, a parametric one-way analysis of variance (ANOVA) was done. In other cases, a nonparametric 

ANOVA (Kruskal-Wallis) was performed. No power calculations were used. All specific details regarding data 

analysis can be found in the original manuscript [6]. 

 

 

Validation of protocol 
 

This protocol was used and validated in Dantas et al. [6]. doi:10.1083/jcb.202205051. The dynamic cell confiner 

was used in Figures 1, 2, 3, 5, S1, S2, and S3. The static cell confiner was used in Figure 4. 

In addition, this protocol or parts of it have been used and validated in the following research articles: 

• Le Berre et al. [7] Methods for two-dimensional cell confinement. Methods Cell Biol.  

• Lancaster et al. [8] Mitotic rounding alters cell geometry to ensure efficient bipolar spindle formation. Dev Cell 

(Figures 1, 4, and 6). 

• Liu et al. [9] Confinement and low adhesion induce fast amoeboid migration of slow mesenchymal cells. Cell. 

• Maiuri et al. [10] Actin flows mediate a universal coupling between cell speed and cell persistence. Cell. 

• Le Berre et al. [11] Fine control of nuclear confinement identifies a threshold deformation leading to lamina 

rupture and induction of specific genes. Integr Biol (Camb).  

 

 

General notes and troubleshooting 
 

General notes 

 

1. pH of solutions should be carefully adjusted using either HCl or NaOH, whenever necessary. For the NaHCO3 

solution, this is extremely relevant as the basic pH facilitates the adhesion of FBN to the coverslip. 

2. The pH of the PBS 10× solution should be adjusted to 7.4 and the solution should be autoclaved afterwards. 

3. Once reconstituted, the FBN solution should be stored at 4 °C for a maximum of two weeks. 

4. The cell confiner and the cell confinement slides used for the static confiner can be acquired commercially 

(4DCell). The dynamic confiner was microfabricated in the lab using an adaptation of the protocol described 

previously [7] to adjust the diameter of the confiner slide to a 10 mm diameter coverslip. Adjust the equipment 

and laboratory supplies according to the purpose of your experiments.  

5. The PAA hydrogels used to create the confining slides can be stored at 4 °C for a week, covered in PBS and 

sealed with parafilm. 

6. When using drugs, prepare a new suction cup for each experimental condition, as the PDMS can uptake 

hydrophobic molecules from the cell medium. Washing is not sufficient to remove them efficiently from the 

PDMS. 

7. The continuous use of antibiotic in the cell culture medium should be avoided. Antibiotics are advised only 

when preparing cells for imaging or fixed-cells analysis. 

8. Use a laminar flow hood to perform all cell manipulation protocols. Prepare, use, store, and dispose of all the 

reagents according to the Material Safety Data Sheet (MSDS) guidelines. All the mediums and buffers used 

for cell culture should be prewarmed unless otherwise stated. 

9. Cells should be used at a low passage number and frequently tested for possible mycoplasma infections. 

10. For 22 mm × 22 mm coverslips and fluorodishes, use 100 μL of FBN 25 mg/mL; for 6-well plates, use 500 

μL of FBN 25 mg/mL per well. For other sizes, adjust the volume accordingly. 
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11. Add a small volume of cell culture medium (usually less than 500 mL) when using the dynamic cell confiner 

to avoid suction of culture medium into the vacuum line attached to the pressure/vacuum generator. 

12. Frequently check the tubing of the vacuum generator to avoid the trapping of air bubbles. This will influence 

the generation of vacuum and therefore affect compression efficiency. 

13. Frequently calibrate the vacuum/pressure controller.  

14. Different volumes can be used according to the dimension of your cell culture dish. For example, for a T75 

flask, use approximately 10 mL of PBS to wash, 3 mL of trypsin to detach the cells, and at least 6 mL of fresh 

medium supplemented with 10% FBS to resuspend the cells.  

15. Dust particles interfere with the attachment of the glass to PDMS. Ensure that the glass is cleaned thoroughly. 

The use of Scotch Magic tape is highly recommended, as it removes dust efficiently without leaving residues. 

16. To count cells using the automated cell counter, prepare a mixture of 10 μL of the cellular suspension and 10 

μL of the Trypan Blue solution. Mix gently and apply 10 μL on the cell counting slide. Then, place the counting 

slide onto the electronic counter device.  

17. The holes that are present in the lid of the cell confinement device allow the access for pipettes through the 

glass plate and can be used to add or aspirate medium and/or drugs. If necessary, these holes can be closed 

with the caps provided in the kit. 

18. Whenever drugs are used in the experiment, they should be added during this incubation step, as PDMS can 

absorb small molecules from the medium. 

19. Confinement experiments were performed in cells confined to a minimum of 8 μm height. This is the minimum 

height that RPE-1 cells can cope without inducing cell death. Other cell types need to be tested.  

 

Troubleshooting 

 

Problem 1: Suction cup not attaching to the 35 mm dish.  

Possible cause: Vacuum is not being generated. 

Solution: Check the tubing for air bubbles. Calibrate the vacuum/pressure generator. Check integrity of the suction 

cup as it needs a flat surface to work. 

 

Problem 2: Cell height varies and is not accurately controlled. 

Possible cause: Micropillar height is not correct or PDMS layer is not flat. 

Solution: Check the integrity of the SU-8 mold as it can deteriorate with use. Make sure that you use a very thin 

layer of PDMS when preparing the confinement slide and press homogeneously over the entire coverslip to ensure 

it is lying flat. 

 

Problem 3: Confinement slide detaching from suction cup. 

Possible cause: Slide is not dry. 

Solution: Make sure the glass side of the confinement slide is thoroughly dried before attaching it to the PDMS 

piston. Any moisture will prevent binding of glass to PDMS. 
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